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Tutorials for MASTAN2 and Related Validation   iii  

PREFACE 
This report creates the tutorials helping engineers to correctly model and analyze structural 
systems comprised of non-doubly symmetric sections using the latest version of MASTAN2. 
The report also validated a MASTAN2 model using non-doubly symmetric sections against 
results from a small test program. The following report and tutorials are provided: 
 
AISI Small Project Summary – Tutorials for MASTAN2 and Related Validation 

• Tutorial for MASTAN2 v5.1 - Introductory Frame 
• Tutorial for MASTAN2 v5.1 - Pour Stop Beam 
• Tutorial for MASTAN2 v5.1 – Steel Joist 

 
The input files for tutorial examples can be downloaded from the link below: 
 

1. Frame tutorial example: 
https://www.dropbox.com/s/u3gik4k8ww9bppi/Frame_End.mat?dl=0 
 

2. Pour-stop example:  
https://www.dropbox.com/s/27qfsqsvqo3iliq/Pour_Stop.mat?dl=0 

 
3. Joist tutorial example: 

https://www.dropbox.com/s/mzizxw5ki9byyff/Joist.mat?dl=0 
 

 
 

https://www.dropbox.com/s/u3gik4k8ww9bppi/Frame_End.mat?dl=0
https://www.dropbox.com/s/27qfsqsvqo3iliq/Pour_Stop.mat?dl=0
https://www.dropbox.com/s/mzizxw5ki9byyff/Joist.mat?dl=0
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Tutorials for MASTAN2 and 
Related Validation
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Project Overview
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Project Objectives

• To create tutorials for engineers on how to correctly model and analyze structural 
systems comprised of non-doubly symmetric sections using the latest version of 
MASTAN2.

Result: Created 3 step-by-step tutorials with multiple screenshots.

• To validate a MASTAN2 model using non-doubly symmetric sections against results 
from a small test program.

Result: Assembled a small system with 2 open web steel joists. Subjected system to 
two loading sequences resulting in two sets of data to compare against 
MASTAN2 against. Results show good agreement. 
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Tutorial Description
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General Tutorial Structure

• Each tutorial starts with an introduction of MASTAN2 and the problem to be solved.

• The initial model is constructed, and an initial evaluation is completed.

• The base model is altered for a second scenario and analyzed again.

• Lastly, some additional piece of information related to the structural analysis is 
provided.

• No one tutorial covers all features in MASTAN2. As a group, these tutorials cover most 
of the new features offered.

1/26/2021 6



Tutorial 1 – Introductory Frame

• A single bay, single story portal frame was analyzed in 2-D and then 3-D to show the 
impact of warping in the modeling process.

• An interior column was added, and non-doubly symmetric abilities were introduced.

• The impact of accounting for the non-doubly symmetric section properties in the overall 
stability of the frame was highlighted.

1/26/2021 7



Tutorial 2 – Pour Stop Beam

• A non-doubly symmetric beam was subjected to uniform distributed loading including 
both transverse shear and torsional moment.

• Details on calculating stresses from MASTAN2 results are provided.

• The abilities of multiple new features of MASTAN2 are presented

1/26/2021 8



Tutorial 3 - Joist

• A joist model was subjected to uniform loading and then a hanging load.

• The model is built using the new import function to create the base geometry and then 
refined within MASTAN2.

• Note: It is similar to the experimental set-up.

1/26/2021 9



Experimental Configuration
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Experimental Set-up
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• (2) 20’ – 16K2A Joists with rolled angle top and bottom chords with rolled channel webs

• Joists braced with cross bracing at end of bottom chords and decking



Test Program

• Scenario 1:
• Joist was subjected to a uniform distributed loaded applied 

via barrels with aggregate.

• At ~0.5 design live load (152 plf) and ~1.0 design live load 
(304 plf), the bottom chord was subjected to 100 lbs of a 
hanging load, P

• Scenario 2:
• No uniform load was applied to joist. 

• The bottom chord was subjected to 280 lbs of a hanging 
load, P

• In both cases the hanging load was applied near 
midspan away from the web intersections

1/26/2021 12
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Testing Images – Scenario 1: Half Live Load
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Testing Images – Scenario 1: Full Live Load

1/26/2021 14



Testing Images – Scenario 2
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Recorded Information

• Recorded displacements using Optotrak system for key translations and rotations.

• Recorded strain data at 5 locations. Each cross section included 4 linear strain gages and 
1 shear strain gage to be able to approximate internal forces.

Strain Measurement Locations

1 – Top of Vertical Web

2 – Bottom of Middle Web

3 – End of Loaded Chord

4 – Midspan of Loaded Chord

5 – Midspan on Other Chord

1/26/2021 16
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Modeling with MASTAN2
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MASTAN2 Model

1/26/2021 18

• Joist members were modeled in an ideal location with a single node connection for the 
intersection of the webs. The ends of the webs were defined to be fixed for out-of-plane 
bending, released for in-plane bending (typical joist web pinned design condition), and 
fixed for warping at the end.

• All members were modeled with the nominal cross section properties in a principal 
orientation.

• Top chord was laterally supported at web intersections, ~24” o.c.

• Bottom chord was laterally supported 8” from end web intersection. Connection was 
inserted above the bottom chord to allow additional twist.



Cross Section Information
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MASTAN2 Loading

1/26/2021 20

• The model includes uniform load applied to each top chord. The loaded load is applied in 
the global Y direction which causes it to be split into the member’s principal orientation.

• The hanging load is applied via a vertical 2.5 inch 3/8” round steel rod modeled at the 
end of a horizontal 1.5 inch rigid link extending from the centroid of the bottom chord. 
The hanging load is applied at the end of the vertical rod to account for movement of the 
eye bolt.

• The results shown account for the uniform load being applied and then the hanging load 
being added to the model in a 2nd order elastic analysis.



Results
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Example Recorded Information

• Strain gage information during Scenario 1

1/26/2021 22

0.5 Live Load + 
Hanging Load

1.0 Live Load + 
Hanging Load



Calculations with Joist Experiment Results

• The displacement information was measured at a few critical locations for comparing 
translations. 

• Most of the displacement information was used to calculate the twist of the bottom 
chord at the 10 sensor group locations.

• At each sensor group, the Euler angle and axis was calculated using 3 of the 4 
displacement measurements and the component of that angle about the original x-axis 
was determined. The final rotation presented was based on the average of the 4 
combinations.

1/26/2021 23



Calculations with Joist Experiment Results

• Using the strain gauge measurements, internal forces were calculated. 

• Two scenarios were considered: 
1) Bimoment and warping were significant meaning all 4 linear strain measurements were needed to 

define the resulting internal forces.

2) Warping was negligible and only 3 strain measurements were need to define the internal forces. 
The resulting forces were calculated excluding one gage and the 4 solutions were averaged.

• The internal forces considered are
• Axial Force, P

• Bending Moment about the y-axis, My

• Bending Moment about the z-axis, Mz

• Bimoment from warping, B

1/26/2021 24



Stress Distributions

• Using the internal forces calculated from the experiment and pulled from MASTAN2, 
the centerline normal stress diagrams were calculated.

• Relationship between normal stress and the internal forces:
• The same relationship was used for calculation on the previous page. 

• A closely spaced path of nodes along the element centerline was defined. The above 
relationship was evaluated at each position.

1/26/2021 25

𝜎𝑥 =
𝑃

𝐴
−
𝑀𝑧𝑦

𝐼𝑧𝑧
−
𝑀𝑦𝑧

𝐼𝑦𝑦
+
𝐵𝜔𝑛
𝐶𝜔



General Comment

• Results related to Position 1 and 2 are not shown. The measurements were taken 3 
inches vertically from the extremes of the joist in an attempt to verify the end 
conditions of the web . This placed the measurements a little farther than the maximum 
dimension of the web channel away from the welded connection.

• While the individual strain gauge measurements displayed the anticipated stepwise 
changes in strain corresponding to the applied hanging load, the results indicated that 
there were likely stress concentration effects being captured from being too close to 
the welded connection. This effect cannot be captured in MASTAN2 and as such was 
not shown here.
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Reference for Rotation Plots
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Result Diagrams – Scenario 1

• This section is all diagrams from Scenario 1.

• Force plots are shown with both the test results considering bimoment from warping 
and from ignoring the effects of warping.

• The stress plots are shown only with the case considering bimoment since at the 
locations checked the values were small.
• At the top of each plot, the range of stresses is provided.

• Stress diagrams have MASTAN2 results on top and Test results on bottom for a given loading. A 
label is provided underneath the x-axis as a reminder.

• Diagrams are scaled in each vertical pair, but not across remaining diagrams.

• Red is tension (+) and blue is compression (-) 
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Measured Global Displacements
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Measured Net Displacements
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Measured Rotations
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Unloaded Member Loaded MemberLoaded Member



Measured Net Rotations
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Unloaded Member Loaded MemberLoaded Member



Force Comparisons
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Force Comparisons
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Force Comparisons
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Net Force Comparisons
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Net Force Comparisons
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Net Force Comparisons
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Stress Comparisons
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Stress Comparisons
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Stress Comparisons
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Stress Comparisons
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Stress Comparisons
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Stress Comparisons
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Stress Comparisons
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Stress Comparisons
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Stress Comparisons
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Stress Comparisons
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Result Diagrams – Scenario 2

• This section is all diagrams from Scenario 2.

• Force plots are shown with both the test results considering bimoment from warping 
and from ignoring the effects of warping.

• The stress plots are shown only with the case considering bimoment since at the 
locations checked the values were small.
• Stress diagrams have MASTAN2 result on top and Test result on bottom for a given loading.

• Diagrams are scaled in each vertical pair, but not across remaining calculations.

• Red is tension (+) and blue is compression (-) 
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Measured Global Displacements
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Measured Bottom Chord Twist
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Unloaded Member Loaded MemberLoaded Member



Force Comparisons
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Force Comparisons
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Force Comparisons
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Stress Comparisons
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Stress Comparisons
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Stress Comparisons
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Extra Information

• While attempting to verify the results with the webs, it was noted that all the cross 
sections were not perfectly formed. 

• One attempt to obtain better results required accounting for this altered geometry. 

• The geometry was measured using the Artec Leo Scanner.

• A 3-D point cloud of the surface was created.
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Extra Information

• The 3-D point cloud mesh could be segmented into separate chunks of information that 
could be used to create a profile.
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Extra Information

• Each profile is of the exterior and a calculation of the interior centerline was created.
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Gap on left
~0.01 inch



Extra Information
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Generic 

Section

Measured 

Section

Error Measured

to Generic
A 0.1587 0.1567 -1.26%
J 3.11E-04 3.07E-04 -1.27%

Izz 7.27E-03 7.90E-03 8.73%
Iyy 2.76E-02 2.65E-02 -4.19%
Iyz 0 0 -
ys -4.72E-01 -4.90E-01 3.82%
zs 0 2.44E-04 -

Cw 7.62E-04 3.94E-04 -48.27%

• The variation in the profile was found to have impact on the section properties; 
however, as mentioned earlier, it is not the controlling issue that was observed.



Summary
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Summary

• MASTAN2 was able to determine reasonable stress distributions matching the 
experiment of a joist subjected to an eccentric hanging load.

• In the calculated results from Scenario 1, there was a consistent underprediction of 
stresses in the initial condition prior to the application of the hanging load.  But looking 
at the net change in Scenario 1 or the total loading in Scenario 2, MASTAN2 was 
consistently finding conservative values for stresses while matching the desired 
distribution of stress for the effect of the torsion applied to the chord.

• The largest variation was observed on the leg of the angle where the hanging load was 
applied 2” away from the strain gauge measurements. 
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Tutorial for MASTAN2 v5.1 -
Introductory Frame
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Section 1: Overview
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This tutorial provides step-by-step guidance for the sample frame structure. Enough details are 

provided that the example model with non-doubly symmetric sections can be completed following 

the instructions here. Not every feature available in MASTAN2 will be mentioned nor utilized in this 

tutorial. For further information on several additional features within MASTAN2, it is recommended 

the user make use of other tutorials at http://www.mastan2.com/tutorial.html. 

Overview

http://www.mastan2.com/tutorial.html
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This tutorial will start with the simple one-bay frame shown on the left. This model will then be 

altered to the two-bay frame shown on the right include non-doubly symmetric sections. Further 

details of each model will be provided in the corresponding section.

Problem Overview

Starting Frame Final Frame
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Section 2: Getting Started
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MASTAN2 is an interactive graphics program that provides preprocessing, analysis, and postprocessing 

capabilities. Preprocessing options include definition of structural geometry, support conditions, applied loads, and 

element properties. The analysis routines provide the user the opportunity to perform first- or second-order elastic 

or inelastic analyses of two- or three-dimensional frames and trusses subjected to static and dynamic loads. 

Postprocessing capabilities include the interpretation of structural behavior through deformation and force 

diagrams, printed output, and facilities for plotting response curves. MASTAN2 is based on MATLAB®, a premier 

software package for numeric computing and data analysis. 

In many ways, MASTAN2 is similar to today’s commercially available software in functionality. The 

number of pre- and post-processing options, however, have been limited in order to minimize the amount of time 

needed for a user to become proficient at its use. The program’s linear and nonlinear analysis routines are based on 

the theoretical and numerical formulations presented in the text Matrix Structural Analysis, 2nd Edition, by McGuire, 

Gallagher, and Ziemian. In this regard, the reader is strongly encouraged to use this software as a tool for 

demonstration, reviewing examples, solving problems, and perhaps performing analysis and design studies. Where 

MASTAN2 has been written in modular format, the reader is also provided the opportunity to develop and 

implement additional or alternative analysis routines directly within the program. 

MATLAB is a registered trademark of The MathWorks, Inc., 3 Apple Hill Drive, Natick, MA 01760-2098.

MASTAN2 General Information
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Two versions of MASTAN2 have been developed and may be installed. One requires you to have 

access to MATLAB and the other does not. Both versions provide the same functionality, except that 

the MATLAB version also provides the user an opportunity to develop and implement additional or 

alternative analysis routines that will directly interact with MASTAN2. Please see the Setup Guides at 

www.mastan2.com.

Launching MASTAN2

Start Here

http://www.mastan2.com/
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In order to minimize the learning time for MASTAN2, its graphical user interface (GUI) has been 

designed using a simple and consistent two menu approach. Using a pull-down menu at the top of the 

GUI, a command is selected. Parameters are then defined in the bottom menu bar and the command is 

executed by using the Apply button.

Base Layout

Main model window

Bottom menu bar

Edit Field

Pull-down menu

Submenu

Button
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Section 3: 2-D Frame Analysis
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The frame is constructed of A992 steel with the properties indicated. The frame is also supported out 

of plane in the Z direction at the ends and middle of the beam. The connections are assumed to be 

fixed for warping.

MASTAN2 does not assume any unit system. Models in MASTAN2 require the use of any consistent 

set of units. This tutorial will use kip and inch.  

A few steps completed as part of this segment of the tutorial are not specifically required for a 2-D 

analysis. Comments are provided to identify them.

Problem Description - Figure

A992 Steel
E=29,000 ksi
fy=50 ksi
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1) Start with a new, empty model. 

2) From the Geometry menu select Define Frame.

3) At the bottom menu bar, click the pop-up menu to the left of bays @ and change 0 to 1. Click in the 

edit box to the right of bays @ and change 0 to 720.

4) Click the pop-up menu to the left of stories @ and change 0 to 1. Click in the edit box to the right of 

stories @ and change 0 to 360.

5) Click on the Apply Button. A one-bay single story frame is now defined.

Clicking the             icon will advance the tutorial to a page that provides an image of the MASTAN2 

interface after the corresponding step is executed. Clicking the          icon on that page will return you 

to the step-by-step instructions.

Geometry Definition
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Note: At first launch you should see MASTAN2 version 
information in bottom bar. This screenshot is from 
a new model after MASTAN2 was already open.
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1) From the Geometry menu select Subdivide Element(s).

2) Create the list of elements by clicking on the horizontal element.

3) Since the number of segments is already set at 2, click on the Apply button.

4) Create a new list of all elements by clicking the All button.

5) Click the > button to the right of # of Segments = to increase 2 to 8. 

6) Click on the Apply button.

Element Modification
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These steps are not technically required; however, it will help makes it easier to find results in the 

model. Additionally, any reference to node or element number will be using this updated reference.

1) From the Geometry menu select Renumber Elements.

2) Click the checkbox to the left of Y-X-Z (2D). Click on the Apply button.

3) From the Geometry menu select Renumber Nodes.

4) Click the checkbox to the left of Y-X-Z (2D). Click on the Apply button.

Model Cleanup
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1) From the Properties menu select Define Section.

2) At the bottom menu bar, click on the Database button. 

3) In the pop-up menu, scroll to find Section: W10x49 and click on it. 

4) Then click on the Apply button. Section 1 is now defined with the properties of W10x49. 

5) Repeat step 3 with Section: W27x84. After clicking the Apply button, Section 2 will be defined.

For the initial 2-D analysis, only Area, I z-z, and Z z-z would be required. The other section properties 

are only needed when moving to 3-D analysis.

Section Properties - Creating
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1) From the Properties menu select Attach Section.

2) At the bottom menu bar, use the buttons to the right of Element(s): to make the list of elements.

3) Click the Adv button to open pop-up menu. To select all the vertical elements, click the check box 

next to the Y-axis option. Click Add to add all vertical elements to the element list. 

4) Click on the Apply button to assign Section 1. (Note that the element line style has changed from 

dash-dot to dashed.)

5) Select the Clr button located to the right of Elements: to clear the list of elements. 

6) Create a list of the remaining elements by clicking the All button and then the Remove button in 

the pop-up menu. This should leave only the horizontal members selected.

7) Change the Section # by clicking on the current section number, 1, just to the right to open a pop-

up menu with all section numbers. Click on 2 to select the W27x84 section. 

8) Assign Section #2 properties by clicking the Apply button.

Section Properties - Assigning
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1) From the Properties menu select Define Material.

2) At the bottom menu bar, click in the edit box just to the right of E= and change the 0 to 29000 (not 

29,000). Similarly, click in the edit box just to the right of Fy= and change the inf to 50. Next, click in 

the edit box to the right of Name: and type A992. Click on the Apply button. (Material #1 is now 

defined with the properties of A992 steel.)

3) From the Properties menu select Attach Material.

4) At the bottom menu bar, create the list of elements to be assigned the properties of Material 1 by 

clicking on the All button to the right of Elements:. Click on the Apply button. (Note that elements 

with assigned section and material properties turn solid.)

Material Properties
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1) From the Conditions menu select Define Fixities.

2) At the bottom menu bar, define a fixed support by clicking in the check boxes just to the left of all 

six degrees of freedom: X-disp, Y-disp, Z-disp, X-rot, Y-rot, and Z-rot.

3) Create the list of nodes to be assigned these fixities by clicking on the bottom two nodes of the 

model, 1 and 25.

4) Click on the Apply button.

5) From the View menu select Fit.

For the initial 2-D analysis, only X-disp, Y-disp, and Z-rot would need to be constrained for full fixity. 

The other fixities are only needed when moving to 3-D analysis.

Support Conditions
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1) From the Conditions menu select Define Forces.

2) At the bottom menu bar, click in the edit box just to the right of PX = and change the 0 to 10.

3) Create the list of nodes to be assigned these forces by clicking on the upper left-hand node, 9.

4) Click on the Apply button.

5) From the Conditions menu select Define Uniform Loads. 

6) Since the loading input is already Element(s) local x’-y’-z’, click in the edit box just to the right of 

wy’ = and change 0 to -0.1.

7) Click the Adv button to open pop-up menu. Create a list of the horizontal elements by clicking the 

All button and then the Remove button in the pop-up menu.

8) Click on the Apply button.

9) From the View menu select Fit.

Loading
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These steps are technically optional as you can complete analysis without saving or applying a title; 

however, this is a good time to complete this.

1) From the File menu select Define title. At the bottom menu bar, click in the edit box to the right of 

Title: and type in a brief description of this effort. This text might include the model title, your 

name, and/or the assignment number. Click on the Apply button.

2) From the File menu select Save As … . After selecting your destination folder, type in the filename 

Frame and click Save. Note that the top of the window has now changed to include the file name 

and directory as well as the time the file was last saved.

Naming and Saving
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1) From the Analysis menu select Static and submenu option 1st-Order Elastic.

2) At the bottom menu bar, click on the pop-up menu just to the right of Analysis Type: and Select 

Planar Frame (x-y).

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, click on the Apply button.

6) From the Results menu select Node Displacements.

7) On the undeflected shape, click on the node of interest in the upper right corner, 33, and its 

components are provided in the bottom menu bar. 

Results:

This can be repeated for other nodes by clicking on them or click in the edit box to the right of Node:, 

enter the value, and click Apply.

2-D First-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

2.688 -0.03312 N/A N/A N/A 0.01235
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, click on the pop-up menu just to the right of Analysis Type: and Select 

Planar Frame (x-y).

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) On the undeflected shape, click on the node of interest in the upper right corner, 33, and its 

components are provided in the bottom menu bar. 

Results:

2-D Second-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

2.852 -0.05354 N/A N/A N/A 0.01243
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Section 4: 3-D Frame Analysis
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As is, the model could be run in 3-D. Previously having entered the complete section properties and 

applying full fixity to the base support nodes would be satisfactory to meet the requirements to run a 

3-D analysis. However, this model would be missing the lateral support of the beam previously 

mentioned in the problem statement. Before proceeding, we will add that support to the frame 

through additional boundary conditions.

1) From the Conditions menu select Define Fixities.

2) At the bottom menu bar, define the lateral support by clicking in the check box to the left of Z-disp. 

3) Create the list of nodes to be assigned these fixities by clicking on the top corner and middle nodes 

of the model: 9, 17, and 33.

4) Click on the Apply button.

5) From the View menu select Defined Views and submenu option Isometric: x-y-z.

Updating for 3-D Analysis
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, click on the pop-up menu just to the right of Analysis Type: and Select 

Space Frame.

3) Click on the Apply button to perform the analysis. 

The analysis should stop with the message Analysis Halted: Limit Reached. Often this message is 

related to the analysis encountering a stability limit. The use of the eigen-buckling tool may help 

identify the problem.

3-D Second-Order Elastic Analysis
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1) From the Analysis menu select Eigen-Buckling and submenu option Elastic Critical Load.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame with the Max. # 

of Modes: set to 1 as desired.

3) Click on the Apply button to perform the analysis.

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, click the edit box to the right of Scale. Change 10 to 30 to amplify the 

deformed geometry in the visualization.

6) Click on the Apply button and the first mode is shown with the Applied Load Ratio identified at the 

top of the screen.

The result indicates that the beam is failing in lateral torsional buckling at only 0.687 times the 

applied load. Currently, the analysis does not include the warping stiffness which increases the 

buckling capacity of the beam. MASTAN2 can account for warping effects if the element’s warping 

end conditions are changed.

3-D Elastic Critical Load
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1) From the Geometry menu select Define Connections and submenu option Torsion.

2) At the bottom menu bar, click on the menu to the right of Warping Restraint for Node i and set the 

value to Continuous. Repeat this for the Warping Restraint for Node j. 

3) Create the list of elements to be assigned continuous warping by clicking on the All button to the 

right of Elements:. Click on the Apply button. Note: no symbol indicates the end is free to warp, a 

blue + indicates continuous warping, and a blue ✳ indicates fixed warping.

4) Click Clr to empty the list of elements. Click on the bottom element of each column and left end 

element of the beam to define the members that start with warping fixed and are continuous.

5) Click on the menu to the right of Warping Restraint for Node i and set the value to Fixed. Node j is 

set from the previous step. Click on the Apply button. 

6) Click Clr to empty the list of elements. Click on the top element of each column and right end 

element of the beam.

7) Click on the menu to the right of Warping Restraint for Node i and set the value to Continuous. 

Click on the menu to the right of Warping Restraint for Node j and set the value to Fixed.

8) Click on the Apply button. 

Adding Warping Effects
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1) From the Analysis menu select Eigen-Buckling and submenu option Elastic Critical Load.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame with the Max. # 

of Modes: set to 1 as desired.

3) Click on the Apply button to perform the analysis.

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, the Scale should still be set to 30 from previous analysis. 

6) Click on the Apply button and the first mode is shown with the Applied Load Ratio identified at the 

top of the screen.

The result indicates that the beam is failing in lateral torsional buckling at 1.31 times the applied load. 

This value is 1.9 times the result when ignoring the effects of warping stiffness. The fact that the 

Applied Load Ratio is greater than 1 means it should now be possible to complete the desired 3-D 2nd

order analysis.

3-D Elastic Critical Load



M
AS

TA
N

2



M
AS

TA
N

2



M
AS

TA
N

2

1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) On the undeflected shape, click on the node of interest in the upper right corner, 33, and its 

components are provided in the bottom menu bar. 

Results:

The deflection response is the same as 2-D as no out-of-plane loading or displacements were added. 

The same axial and flexural deformations are being modeled. The introduction of the 3-D analysis 

highlighted the existing out-of-plane instability and the analysis could not proceed past the 

bifurcation load in the perfect model. 

3-D Second-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

2.852 -0.05354 0 0 0 0.01243
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Section 5: Using MSASect
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The section properties used so far have been for doubly symmetric cross sections where we would 

have looked up the values or calculated them outside the program for ourselves. The updated version 

of MASTAN2 includes a new tool MSASect that can calculate section properties for thin wall cross 

sections. MSASect can be used with open and closed cross sections whether symmetric or not. In 

addition to the section properties used thus far, MSASect will calculate the necessary non-doubly 

symmetric section properties. The tool is found within the Define Section and Modify Section menu. 

As a demonstration, the section properties of a W27x84 cross section will be found.

MSASect
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The W27x84 cross section is shown below. Figure A illustrates the full cross section with fillets that is 

associated with the AISC table values. Figure B illustrates the simplified section with overlap and no 

fillets that represents the cross section to be calculated by MSASect. These are the dimensions to be 

entered when working with the template. Figure C illustrates the resulting node to node model 

created when using the template that will be used for calculations in MSASect.

Cross Section Geometry
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1) From the Properties menu select Define Section.

2) At the bottom menu bar, click on the pop-up menu on the far right that currently displays Basic. 

Click on Advanced and new edit boxes and buttons should appear.

3) Click on MSASect.

4) As the I-beam cross-section is selected by default, click the edit box to the right of B1= and enter 

10. Repeat to define B2=10, D=26.7, t1=0.64, t2=0.64, and t3=0.46. 

Note: The dimensions to enter in the template correspond to Figure B on the previous page. While the section 

property calculations need to be completed using the dimensions shown in Figure C, this information is 

automatically generated based on the assumption that the numbers provided followed Figure B. 

5) Click Calculate to determine the properties.

6) Click edit box to right of Name: and enter W27x84Hand.

7) Click Export to MASTAN2 to copy values to main program. 

8) Click Close to return to the main window. There will often be a confirmation when closing it.

9) Click Apply to define Section 3.

Using MSA Sect
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1) From the Properties menu select Information and submenu option Section.

2) Change the Section # by clicking on the current section number just to the right to open a pop-up 

menu with all section numbers. Click on 2 to view the Section Properties based on the AISC 

database. Repeat with clicking on 3 to see the MSASect calculated values. 

From the comparison of section properties from AISC and the values calculated by MSASect, most of 

the calculated properties match well. Take note that some of the template shapes calculate standard 

shear area values. To match the previous analysis, the A v-v and A w-w would need to be set to inf.

MSASect Results

Property Units AISC MSASect Difference

A in2 24.7 24.79 0.4 %

Izz in4 2850 2852 0.1 %

Iyy in4 106 106.9 0.8 %

J in4 2.81 2.59 -7.7 %

Cw in6 18000 18110 0.6 %

Zzz in3 244 244.9 0.4 %

Zyy in3 33.2 32 -3.6 %
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If one of the default cross sections does not cover your situation the General option allows for the 

input of nodes and line segments by the user. Clicking the radio button next to General and then the 

Next button will open an interface that allows for the input of nodes and line segments directly. If you 

want to verify the final node coordinates used or tweak a default geometry, click Convert to General 

to gain access to the list of nodes and line segments automatically created in the MSASect interface. 

The following is an example of what the W24x87 would look like. Note that the coordinates 

correspond with Figure C shown previously.

Using MSA Sect
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Doubly Symmetric Sections
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The frame is constructed of A992 steel with the properties indicated. The frame is also supported out 

of plane in the Z direction on the beam at the column locations. The outer columns and top beam are 

assumed to be fixed for warping at the end. The beam is also continuous for warping over the middle 

column. The middle column is assumed to be free to warp at each end. 

Problem Description - Figure

A992 Steel
E=29,000 ksi
fy=50 ksi
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1) From the Geometry menu select Define Node.

2) At the bottom menu bar, click in the edit box to the right of x = and enter 360. Click in the edit box 

to the right of y = and enter 0. Click in the edit box to the right of z = and enter 0.

3) Click on the Apply Button.

4) From the Geometry menu select Define Element.

5) On the model, click the newly created node to define Node i. Then click the middle node of the top 

beam to define Node j. These nodes should be 34 and 17, respectively.

6) Click on the Apply Button.

Adding Interior Column
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1) From the Properties menu select Attach Material.

2) Create the list of elements to be assigned the properties of Material 1 by clicking on the new 

column. Click on the Apply button. (Note that elements with assigned just material properties turn 

dotted.)

3) From the Properties menu select Define Section.

4) At the bottom menu bar, click on the Database button. 

5) In the pop-up menu, scroll to find section W8x35 and click on it. Then click on the Apply button. 

(Section 4 is now defined with the properties of W8x35.) 

6) From the Properties menu select Attach Section.

7) Create the list of elements to be assigned the properties of Section 4 by clicking on the new 

column, element 33. 

8) Change the Section # by clicking on the current section number just to the right to open a pop-up 

menu with all section numbers. Click on 4 to select Section #4, W8x35. 

9) Assign Section 4 properties by clicking the Apply button.

Applying Material and Section Properties
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1) From the Geometry menu select Subdivide Element(s).

2) Create the list of elements by clicking on the new column.

3) Click the > box to the right of # of Segments = to increase 2 to 8. 

4) Click on the Apply button. (Note that same the section and material property information is given 

to all new elements.)

5) From the Conditions menu select Define Fixities.

6) At the bottom menu bar, define a pin support by clicking in the check boxes just to the left of X-

disp, Y-disp, and Z-disp.

7) Create the list of nodes to be assigned this fixity by clicking on the middle bottom node, 34.

8) Click on the Apply button.

Element Modification
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1) From the Geometry menu select Define Connections and submenu option Torsion.

2) At the bottom menu bar, click on the menu to the right of Warping Restraint for Node i and set the 

value to Continuous. Repeat this for the Warping Restraint for Node j. 

3) Use the buttons to the right of Element(s): to make the list of elements. Click the Adv button to 

open the pop-up menu. To select all the middle column elements, click the Off button to the right of 

Range (Inclusive) to turn this tool On. Click the edit box to the left of X and change –Inf to 359. 

Click the edit box to the right of X and change Inf to 361.

4) Click Add to add all these elements to the element list. Click on the Apply button to assign 

continuous warping.

Warping Continuity
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1) Click Adv to close the pop-up menu.

2) Click Clr to empty the list of elements. Click on the bottom element of the middle column to define 

the member that start with warping free and is continuous.

3) Click on the menu to the right of Warping Restraint for Node i and set the value to Free. Node j is 

set from the previous step. 

4) Click on the Apply button. 

5) Click Clr to empty the list of elements. Click on the top element of the middle column.

6) Click on the menu to the right of Warping Restraint for Node i and set the value to Continuous. 

Click on the menu to the right of Warping Restraint for Node j and set the value to Free.

7) Click on the Apply button.

Warping Boundary Conditions
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1) From the Geometry menu select Define Connections and submenu option Flexure.

2) At the bottom menu bar, click on the menu to the right of Type for Node j and set the value to 

Pinned. 

3) Create the list of elements by clicking on the top element of the middle column. 

4) Click on the Apply button to apply the pin connection. Note the orange circle is displayed to signify 

the end that has the Mx and My moment released. Torsion cannot be released. 

End Moment Release
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1) From the Properties menu select Modify Section.

2) At the bottom menu bar, Section #1 should be selected already. Click on the pop-up menu on the 

far right that current displays Basic. Click on Advanced.

3) Click on MSASect.

4) As the I-beam cross-section is selected by default, click the edit box to the right of B1= and enter 

10. Repeat to define B2=6, D=13, t1=0.625, t2=0.375, and t3=0.3125. 

5) Click Calculate to determine the properties.

6) Click edit box to right of Name: and enter Mono I

7) Click Export to MASTAN2 to copy values to main program. Then click Close to return.  

8) Click Apply to modify Section 1.

Modifying Section Properties
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1) Since the section was modified, the exterior columns are already assigned the appropriate section. 

The orientation just needs to be verified.

2) From the Geometry menu select Re-orient Element(s).

3) From the View menu select Labels and submenu option Element local x’-y’-z’ axes. Each axis is 

shown with a different color line drawn in the positive direction. The x axis is purple, the y axis is 

blue, and the z axis is red. 

4) At the bottom menu bar, click in the edit box to the right of Beta (Deg) and change 0.0 to 180. 

5) Use the buttons to the right of Element(s): to make the list of elements. Click the Adv button to 

open the pop-up menu. To select all the right column elements, click the edit box to the left of X and 

change 359 to 400. Click the edit box to the right of X and change 361 to 800.

6) Click Add to add all these elements to the element list. Click on the Apply button to re-orient the 

elements.

Column Orientation



M
AS

TA
N

2



M
AS

TA
N

2



M
AS

TA
N

2

1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) On the undeflected shape, click on the node of interest in the upper right corner, 33, and its 

components are provided in the bottom menu bar. 

Results:

3-D Second-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

2.395 -0.02608 0 ~0 ~0 -1.304e-4
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This final frame could also have been modeled with MASTAN2 using only the symmetric section 

properties. Since the frame was loaded only in plane and the non-doubly symmetric effects were not 

activated, the user would find that it is possible to recreate the frame without the use of advanced 

section properties and only input the basic section properties and calculate similar displacements.

However, the evaluation of the critical buckling loads of the structure does capture the non-doubly 

symmetric effects. Different behavior could be observed if the user were to compare such an analysis 

on the frame with basic and advanced section properties. The first mode and second mode are very 

similar as the buckling behavior is controlled by the doubly symmetric elements. The third mode 

displays distinctly different behavior as the column is weaker considering singly symmetric behavior. 

Additional Analysis

Disp X Disp Y Rot Z

Basic 2.395 -0.02608 -1.304e-4

Advanced 2.395 -0.02608 -1.304e-4

Mode #1 Mode #2 Mode #3

Basic 2.160 2.806 4.936

Advanced 2.160 2.805 4.040
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This completes the tutorial.
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Tutorial for MASTAN2 v5.1 -
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Section 1: Overview
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This tutorial provides step-by-step guidance for the sample pour stop beam evaluation. Enough 

details are provided that the example model with non-doubly symmetric sections can be completed 

following the instructions here. Not every feature available in MASTAN2 will be mentioned nor 

utilized in this tutorial. For further information on many of the features within MASTAN2 make use of 

other tutorials at http://www.mastan2.com/tutorial.html. 

Overview

http://www.mastan2.com/tutorial.html
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This tutorial completes the analysis of a simply supported non-doubly symmetric section in 

MASTAN2 and some of the related stress calculations. The section considered is a pour stop that is 

simply supported. The values used in this tutorial come from the Steel Deck Institute’s Technical Note 

– No. 3: Pour Stops as Beams. 

Problem Overview

Simple Supported Beam Cross Section
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Section 2: Getting Started
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MASTAN2 is an interactive graphics program that provides preprocessing, analysis, and postprocessing 

capabilities. Preprocessing options include definition of structural geometry, support conditions, applied loads, and 

element properties. The analysis routines provide the user the opportunity to perform first- or second-order elastic 

or inelastic analyses of two- or three-dimensional frames and trusses subjected to static and dynamic loads. 

Postprocessing capabilities include the interpretation of structural behavior through deformation and force 

diagrams, printed output, and facilities for plotting response curves. MASTAN2 is based on MATLAB®, a premier 

software package for numeric computing and data analysis. 

In many ways, MASTAN2 is similar to today’s commercially available software in functionality. The 

number of pre- and post-processing options, however, have been limited in order to minimize the amount of time 

needed for a user to become proficient at its use. The program’s linear and nonlinear analysis routines are based on 

the theoretical and numerical formulations presented in the text Matrix Structural Analysis, 2nd Edition, by McGuire, 

Gallagher, and Ziemian. In this regard, the reader is strongly encouraged to use this software as a tool for 

demonstration, reviewing examples, solving problems, and perhaps performing analysis and design studies. Where 

MASTAN2 has been written in modular format, the reader is also provided the opportunity to develop and 

implement additional or alternative analysis routines directly within the program. 

MATLAB is a registered trademark of The MathWorks, Inc., 3 Apple Hill Drive, Natick, MA 01760-2098.

MASTAN2 General Information
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Two versions of MASTAN2 have been developed and may be installed. One requires you to have 

access to MATLAB and the other does not. Both versions provide the same functionality, except that 

the MATLAB version also provides the user an opportunity to develop and implement additional or 

alternative analysis routines that will directly interact with MASTAN2. Please see the Setup Guides at 

www.mastan2.com. 

Launching MASTAN2

Start Here

http://www.mastan2.com/
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In order to minimize the learning time for MASTAN2, its graphical user interface (GUI) has been 

designed using a simple and consistent two menu approach. Using a pull-down menu at the top of the 

GUI, a command is selected. Parameters are then defined in the bottom menu bar and the command is 

executed by using the Apply button.

Base Layout

Main model window

Bottom menu bar

Edit Field

Pull-down menu

Submenu

Button
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Section 3: Beam Modeling
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The pour stop is a cold-form steel cross-section. The section is subjected to a uniform lateral and 

uniform vertical load as well as a distributed torsion. The model itself will be a simply supported beam 

with the ends fixed for torsion, but free to warp. Details on the applied load are on the next page.

MASTAN2 does not assume any unit system. Models in MASTAN2 require the use of a consistent set 

of units. This tutorial will use pound and inch for the model. The later section of the tutorial that 

determines the internal stresses does include a unit conversion to show stresses in ksi.

Problem Description - Figure

Steel Properties
E=29,500 ksi
fy=33 ksi
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The pour stop is subjected to a uniform surcharge load, a pressure from the wet concrete, self-weight, 

and a linear load from similar sources due to interactions with the deck. Uniform distributed loads are 

available in MASTAN2; however, distributed torsional moments are not possible. To obtain a similar 

effect the loading will be applied via concentrated point loads and concentrated moments with many 

smaller elements along the length of the member

Problem Description - Loading

Resulting Loads
wy = 74.0 plf ↓

= 6.17 pli ↓

wz =  35.4 plf
=  2.95 pli

mx =  104.5 in-lb/ft ↻
=  8.71 in-lb/in ↻

Load Details
See SDI Tech No. 3 for 
additional information

p1 = 20 psf
p2 = 103.3 psf

wd =  0 plf ↓

Coordinates
Lower Corner = (0 in, 0 in)
C = (-2.0677 in, 1.8405 in)

S = (0.16051 in, 0.052335 in)
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The real pour stop has the rounded geometry shown on the left. The rounded segments, particularly 

at the top, could be defined by many closely spaced nodes to account for the full radius. However, this 

tutorial will use the simplified geometry shown on the right based on SDI Tech No. 3.

Problem Description – Cross Section
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1) Start with a new, empty model. 

2) From the Geometry menu select Define Node.

3) At the bottom menu bar, click in the edit box to the right of x = and enter 0. Click in the edit box to 

the right of y = and enter 0. Click in the edit box to the right of z = and enter 0.

4) Click on the Apply Button.

5) From the Geometry menu select Extrude Element.

6) At the bottom menu bar, click on Node 1 to populate the list of nodes. Click in the edit box to the 

right of Delta x = and change 0 to 2. 

7) Repeatedly click the > button to the right of Times = to increase 1 to 24. 

8) Click on the Apply Button.

Clicking the             icon will advance the tutorial to a page that provides an image of the MASTAN2 

interface after the corresponding step is executed. Clicking the          icon on that page will return you 

to the step-by-step instructions.

Geometry Definition
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Note: At first launch you should see MASTAN2 version 
information in bottom bar. This screenshot is from 
a new model after MASTAN2 was already open.
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1) From the View menu select Defined Views and submenu option Isometric: x-y-z.

2) Now with the main member defined, continue to use Extrude Element to illustrate cross section.

3) At the bottom menu bar, click on node 13 to populate the list of nodes. Click in the edit box to the 

right of Delta y = and change 0 to -1.8405. Click in the edit box to the right of Delta z = and change 

0 to 2.0677.

4) Click on the Apply Button to define an element connecting the centroid to the lower corner of the 

pour stop cross section which was labeled N2 in the previous cross-section definition.

5) At the bottom menu bar, click on Node 26 to populate the list of nodes. Click in the edit box to the 

right of Delta z = and change 0 to -8. Click on the Apply Button.

Note: If there was another position along the bottom flat where the deflection was of interest, 2 

elements could be extruded by altering the process to extrude twice in the z direction with the 

appropriate Delta z values or by subdividing the bottom element and then moving the new node to 

the appropriate location.

Cross Section Visualization
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1) Continue defining the cross section by clicking on Node 26 to populate the list of nodes. Click in the 

edit box to the right of Delta y = and change 0 to 6.6862. Click on the Apply Button.

2) Click on Node 28 to populate the list of nodes. Click in the edit box to the right of Delta y = and 

change 0 to 0.2092. Click in the edit box to the right of Delta z = and change 0 to -0.2092. Click on 

the Apply Button.

3) Click on Node 29 to populate the list of nodes. Click in the edit box to the right of Delta y = and 

change 0 to -0.0613. Click in the edit box to the right of Delta z = and change 0 to -0.1479. Click on 

the Apply Button.

4) Click on Node 30 to populate the list of nodes. Click in the edit box to the right of Delta y = and 

change 0 to -0.3535. Click in the edit box to the right of Delta z = and change 0 to -0.3535. Click on 

the Apply Button.

Note: For the area where nodes are close together, from the View menu select Zoom Box to be able 

to zoom in and easier identify which node you are clicking.

Cross Section Visualization Finish
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1) From the Properties menu select Define Section.

2) At the bottom menu bar, click on the pop-up menu on the far right that currently displays Basic. 

Click on Advanced.

3) Click on MSASect.

4) After the interface loads, click on General to select the radio button next to it.

5) Click Next to open the editable dialog boxes. 

6) Click the edit box to the right of ID: and enter 1. Click the edit box to the right of Z-Coor.= and 

enter -8. Click the edit box to the right of Y-Coor.= and enter 0. Click Add to save the node.

7) Repeat entering the values below for each node clicking Add after each one.

Creating Section Properties

ID: 2 3 4 5 6

Z-Coor.= 0 0 -0.2092 -0.3571 -0.7107

Y-Coor.= 0 6.6862 6.8954 6.8341 6.4806
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1) Under the segments section, click the edit box to the right of ID: and enter 1. Click the edit box to 

the right of Start Node= and enter 1. Click the edit box to the right of End Node= and enter 2. Click 

the edit box to the right of Thickness= and enter 0.1046. Click Add to save the segment.

2) Repeat entering the values for each segment updating the ID:, Start Node=, and End Node= values 

by adding 1 to each number until all 5 segments are entered. Click Add after each to save.

3) Click Calculate to determine the properties.

4) Click edit box to right of Name: and enter Pour Stop.

5) Click Export to MASTAN2 to copy values to main program. Then click Close to return.

6) Click Apply to save Section 1.

Creating Section Properties – Cont.
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1) From the Properties menu select Attach Section.

2) At the bottom menu bar, use the buttons to the right of Element(s): to make the list of elements.

3) Create a list of the elements by clicking the All button. 

4) Click on the Apply button to assign Section 1. 

Section Properties - Assigning
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1) From the Properties menu select Define Material.

2) At the bottom menu bar, click in the edit box just to the right of E= and change the 0 to 29500000

(not 29,500,000). Similarly, click in the edit box just to the right of Fy= and change the inf to 33000. 

Next, click in the edit box to the right of Name: and type Steel. 

3) Click on the Apply button to save Material #1.

4) From the Properties menu select Attach Material.

5) At the bottom menu bar, create the list of elements to be assigned the properties of Material 1 by 

clicking on the All button to the right of Elements:. Click on the Apply button. 

Since the self-weight is already included in the loading summary, a self-weight was left as zero. If the 

self-weight was to be included through MASTAN2, a second weightless material would need to be 

defined and assigned to the members that are being used to visualize the cross section.

Material Properties
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1) From the Conditions menu select Define Fixities.

2) At the bottom menu bar, define a pin support with torsion fixed support by clicking in the check 

boxes just to the left of X-disp, Y-disp, Z-disp, and X-rot.

3) Create the list of nodes to be assigned this fixity by clicking on node 1.

4) Click on the Apply button.

5) At the bottom menu bar, define a roller support with torsion fixed support by clicking in the check 

boxes just to the left of X-disp to release it and leave Y-disp, Z-disp, and X-rot constrained.

6) Click Clr to empty the list of nodes. 

7) Create the list of noes to be assigned this fixity by clicking on node 25. 

8) Click on the Apply button.

Support Conditions
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1) From the Geometry menu select Define Connections and submenu option Torsion.

2) At the bottom menu bar, click on the menu to the right of Warping Restraint for Node i and set the 

value to Continuous. Repeat this for the Warping Restraint for Node j. 

3) Click the Adv button to open pop-up menu. Click the check box next to the X-axis option. 

4) Create the list of elements to be assigned continuous warping by clicking on the Add button to the 

advanced menu. Then click on the Apply button. 

5) Click Clr to empty the list of elements. Click on the left most element of the beam. 

6) Click on the menu to the right of Warping Restraint for Node i and set the value to Free. Node j is 

set from the previous step. Click on the Apply button. 

7) Click Clr to empty the list of elements. Click on the right most element of the beam. This might 

require you to click Adv to close the pop-up menu.

8) Click on the menu to the right of Warping Restraint for Node i and set the value to Continuous. 

Click on the menu to the right of Warping Restraint for Node j and set the value to Free.

9) Click on the Apply button. 

Adding Warping Effects
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1) From the Conditions menu select Define Forces.

2) At the bottom menu bar, click in the edit box just to the right of PY = and change 0 to -12.34. Click 

in the edit box just to the right of PZ = and change 0 to 5.9.

3) Click the Adv button to open the pop-up menu. To select the main beam nodes, change the edit box 

to the left of Z to -1. Change the edit box to the right of Z to 1.

4) Click Add to add all main beam nodes.

5) Click on the Apply button. 

6) From the Conditions menu select Define Moments.

7) At the bottom menu bar, click in the edit box just to the right of Mx = and change 0 to -17.42. 

8) Click the Adv button to open the pop-up menu. To select the main beam nodes, change the edit box 

to the left of Z to -1. Change the edit box to the right of Z to 1.

9) Click Add to add all main beam nodes.

10)Click on the Apply button. 

Loading
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These steps are technically optional as you can complete analysis without saving or applying a title; 

however, this is a good time to complete this.

1) From the File menu select Define title. At the bottom menu bar, click in the edit box to the right of 

Title: and type in a brief description of this effort. This text might include the model title, your 

name, and/or the assignment number. Click on the Apply button.

2) From the File menu select Save As … . After selecting your destination folder, type in the filename 

Pour_Stop and click Save. Note that the top of the window has now changed to include the file 

name and directory as well as the time the file was last saved.

Naming and Saving
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1) From the Analysis menu select Static and submenu option 1st-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, click on the Apply button.

6) From the Results menu select Node Displacements.

7) On the undeflected shape, click on the midspan node of interest, node 13, and the displacements 

for base 6 degree of freedoms are provided in the bottom menu bar. 

Results:

8) Clicking on any of the additional nodes representing the cross section will cause the displacements 

at that location due the combined effects of rotation and translation to be displayed. These 

deflections do not account for any local axial displacement due to warping though.

First-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

~0 -0.08033 -0.0598 -0.03472 ~0 ~0
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, click on the Apply button.

6) From the Results menu select Node Displacements.

7) On the undeflected shape, click on the midspan node of interest, node 13, and the displacements 

for base 6 degree of freedoms are provided in the bottom menu bar. 

Results:

The values are similar to the 1st-order results but capture the change in the applied torsion that exists 

in the deformed condition. The analysis does not account for any change in the direction the load 

would be applied. The applied loads will remain in the initial orientation. 

Second-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

-2.992e-4 -0.08758 -0.06218 -0.03726 ~0 ~0
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Section 4: Results and Stresses
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The next section of this tutorial will provide instructions on how it is possible to calculate the internal 

stresses from the MASTAN2 output information.  After showing how to locate the necessary 

information from within MASTAN2, the next few pages will provide background and the sign 

conventions that are used with MASTAN2 to calculate the internal stresses. Some information is 

provided on how this information can be calculated. Finally, the resulting stresses at midspan are 

identified using the 2nd-order analysis internal forces.

Notes:

The internal forces taken from MASTAN2 are presented with the sign convention shown on the 

following page. Also included are the required transformations to get to a principal orientation.

The stress calculations will account for this information.

Using Internal Forces
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Sign Conventions

𝑉𝑣
𝑉𝑤

=
𝑐𝑜𝑠𝜙 𝑠𝑖𝑛𝜙
−𝑠𝑖𝑛𝜙 𝑐𝑜𝑠𝜙

∙
𝑉𝑦
𝑉𝑧

𝑀𝑣

𝑀𝑤
=

𝑐𝑜𝑠𝜙 −𝑠𝑖𝑛𝜙
𝑠𝑖𝑛𝜙 𝑐𝑜𝑠𝜙

∙
𝑀𝑦

𝑀𝑧

𝑣𝑠
𝑤𝑠

=
𝑐𝑜𝑠𝜙 𝑠𝑖𝑛𝜙
−𝑠𝑖𝑛𝜙 𝑐𝑜𝑠𝜙

∙
𝑦𝑠
𝑧𝑠
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1) From the Results menu select Element Forces.

2) On the undeflected shape, click on the element of interest, element 13, and the internal forces are 

provided in the bottom menu bar. These are the forces at the start of the member and the middle of 

the beam. 

3) These forces will be used to calculate the stresses at the middle of the beam.

4) At the bottom menu bar, drag the slider in the left-hand corner until the position indicator located 

to the right displays 1.00L. 

5) Click on the Apply button. These are the forces at the end of the member. 

6) From this position, the bimoment is required to appropriately divide the longitudinal moment into 

the standard twisting and warping components for stress calculations.

7) Repeat steps 2 through 5 for element 1 to obtain the end forces to calculate the controlling shear 

location.

Forces at the start of element 1 Forces at the end of element 1

Getting Internal Forces
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The internal normal stresses can be calculated in the geometric orientation by

This relationship simplifies when working in the principal orientation to 

Normal Stresses

𝜎𝑥 =
𝑃

𝐴
−

𝑀𝑦𝐼𝑦𝑧 +𝑀𝑧𝐼𝑦𝑦 𝑦 + (𝑀𝑦𝐼𝑧𝑧 +𝑀𝑧𝐼𝑦𝑧)𝑧

𝐼𝑦𝑦𝐼𝑧𝑧 − 𝐼𝑦𝑧
2 +

𝐵𝜔𝑛

𝐶𝜔

𝜎𝑥 =
𝑃

𝐴
−
𝑀𝑤𝑣

𝐼𝑤𝑤
−
𝑀𝑣𝑤

𝐼𝑣𝑣
+
𝐵𝜔𝑛

𝐶𝜔
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As part of calculating the shear stresses, the torsional moment must be separated into the component 

from twisting and the component of warping. 

The maximum shear stress is the combination of the stress from transverse shear (𝜏𝑉), the change in 

bimoment (𝜏𝐵), and torsion (𝜏𝑇). The transverse and warping terms are approximately uniform across 

the thickness of the element, whereas torsion linearly varies across the thickness with the extreme 

value at the surface. 

Shear Stresses

𝜏𝑉 =
−𝑉𝑧𝐼𝑦𝑧 + 𝑉𝑦𝐼𝑦𝑦 ത𝑦 + (𝑉𝑧𝐼𝑧𝑧 − 𝑉𝑦𝐼𝑦𝑧) ҧ𝑧

𝐼𝑦𝑦𝐼𝑧𝑧 − 𝐼𝑦𝑧
2 𝑡

𝐴𝑠

𝜏𝑇 =
𝑇𝑇𝑡

𝐽
𝜏𝐵 = −

𝑇𝜔𝑆𝜔
𝐼𝜔

𝜏𝑉 =
𝑉𝑣 ҧ𝑣

𝐼𝑤𝑤𝑡
𝐴𝑠 +

𝑉𝑤 ഥ𝑤

𝐼𝑣𝑣𝑡
𝐴𝑠

𝑀𝑥 − 𝑧𝑠𝑉𝑦 + 𝑦𝑠𝑉𝑧 = 𝑀𝑥 −𝑤𝑠𝑉𝑣 + 𝑣𝑠𝑉𝑤 = 𝑇𝑇 − 𝑇𝜔

𝑇𝜔 =
𝑑

𝑑𝑥
𝐵 ≈

Δ𝐵

Δ𝐿
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Determining the stresses from warping, both shear stresses and normal stresses, requires the use of 

warping coefficients. The values can be calculated based on the equations show below with additional 

details in the following documents. These documents also provide additional information on the 

stresses calculated as well.

(1) AISC Design Guide 9 (Paul A. Seaburg and Charles J. Carter, 2003) 

(2) SDI Technical Note 3. (Steel Deck Institute, 2018)

𝜔𝑛𝑠 =
1

𝐴
න
0

𝑏

𝜔𝑜𝑠 𝑡 𝑑𝑠 − 𝜔𝑜𝑠

𝜔𝑜𝑠 = න
0

𝑠

𝜌0 𝑑𝑠

Different programs exist that can assist in this calculation. One alternative is to make use of CUFSM 

to calculate these values.  The values for the current section are shown here. 

Calculating Warping Constants
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Each of the items below will link to a stress distribution for the centerline. Note moments and shears 

below are in the principal orientation.

1) Axial stress from bending moment: My & Mz & Axial stress from warping: B

2) Total axial stress from P, My, Mz, & B

3) Shear stress from transverse shear: Vy & Vz & Shear stress from warping: Tω

4) Combined shear stress from Vy, Vz, & Tω & Shear stress from twisting: TT

No total combined shear stress is shown as the warping and transverse shear stress components are 

the same across the thickness of the section while the torsional component varies linearly across the 

thickness of the section with 0 stress at the centerline to ± the value shown at the extremes.

Resulting Internal Stresses
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Section 5: Additional Options
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MASTAN2 has many options of what can be done. For this tutorial, three ideas are presented. Each 

possibility is completed starting with the initial model completed to this point. To compare to each of 

the following, it is recommended to make sure you have a base version of this model saved to be able 

to start over.

1) Applying uniform loading instead of point loads for the lateral loading.

2) Adjusting the boundary conditions to consider the effects of fixed warping.

3) Updating the model to calculate the results for other lengths or check other critical geometry.

Other Possibilities
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While a distributed moment loading is not currently available in MASTAN2, it would be possible to 

use a distributed uniform load instead of point loads using the steps below.

1) From the Conditions menu select Define Forces.

2) At the bottom menu bar, all loads should be 0.

3) Click the All button to populate the list of nodes. 

4) Click on the Apply button to remove all point loads. 

5) From the Conditions menu select Define Uniform Loads.

6) At the bottom menu bar, click on Element(s) local x’-y’-z’ to open the drop-down menu. Select 

System global X-Y-Z. 

7) Click in the edit box just to the right of Wy = and change 0 to -6.17. Click in the edit box just to the 

right of Wz = and change 0 to -2.95. Click the Adv button to open pop-up menu. Ensure the check 

box next to the X-axis option is selected. 

8) Click Add to add the main beam elements to the element list. 

9) Click on the Apply button. 

1) Uniform Loading
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) On the undeflected shape, click on the midspan node of interest, node 13, and the displacements 

for base 6 degree of freedoms are provided in the bottom menu bar. 

Results:

The values are similar to using point loads as the model was meshed adequately. If one would be 

working with less elements with a longer length, a greater variation would be expected with bending 

moment. There is not an effect of distributed torsion included.

1) Uniform Loading -- Second-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

-2.992e-4 -0.08758 -0.06217 -0.03726 ~0 ~0



M
AS

TA
N

2



M
AS

TA
N

2

The use of MASTAN2 allows for different boundary conditions. While the model does not need to 

have symmetric supports, for a reference solution the ends were left as pin supports with torsion 

fixed while the warping constraint was changed to fixed. 

1) From the Geometry menu select Define Connections and submenu option Torsion.

2) Click on the left most element of the beam.

3) At the bottom menu bar, click on the menu to the right of Warping Restraint for Node i and set the 

value to Fixed. Click on the menu to the right of Warping Restraint for Node j and set the value to 

Continuous. 

4) Click on the Apply button. 

5) Click Clr to empty the list of elements. Click on the right most element of the beam. This might 

require you to click Adv to close the pop-up menu.

6) Click on the menu to the right of Warping Restraint for Node i and set the value to Continuous. 

Click on the menu to the right of Warping Restraint for Node j and set the value to Fixed.

7) Click on the Apply button. 

2) Alternate Boundary Conditions
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) Click on the midspan node of interest, node 13, and the displacements for base 6 degree of 

freedoms are provided in the bottom menu bar. 

Results:

6) From the Results menu select Element Forces.

7) On the undeflected shape, click on the element of interest, element 13, and the internal forces are 

provided in the bottom menu bar. These are the forces at the start of the member and the middle of 

the beam. 

2) Alternate Boundary Conditions -- 2nd-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

-2.684e-5 -0.02776 -0.01727 -0.01106 ~0 ~0
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A newer feature of MASTAN2 allows for the length of the model to quickly updated.

1) From the Geometry menu select Scale Node(s).

2) At the bottom menu bar, click in the edit box to the right of Cx = and change 1 to 0.5. This will scale 

the model only in the x-direction making the overall length of the beam 24 inches. 

3) Click the All button to populate the list of nodes. 

4) Click on the Apply button.

3) Updating the Geometry -- Scaling
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1) From the Conditions menu select Define Forces.

2) At the bottom menu bar, click in the edit box just to the right of PY = and change 0 to -6.17. Click in 

the edit box just to the right of PZ = and change 0 to 2.95.

3) Click the Adv button to open the pop-up menu. To select the main beam nodes, change the edit box 

to the left of Z to -1. Change the edit box to the right of Z to 1.

4) Click Add to add all main beam nodes.

5) Click on the Apply button. 

6) From the Conditions menu select Define Moments.

7) At the bottom menu bar, click in the edit box just to the right of Mx = and change 0 to -8.71. 

8) Click the Adv button to open the pop-up menu. To select the main beam nodes, change the edit box 

to the left of Z to -1. Change the edit box to the right of Z to 1.

9) Click Add to add all main beam nodes.

10)Click on the Apply button.

3) Updating the Geometry – Update Loading
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Node Displacements.

5) Click on the midspan node of interest, node 13, and the displacements for base 6 degree of 

freedoms are provided in the bottom menu bar. 

Results:

6) From the Results menu select Element Forces.

7) On the undeflected shape, click on the element of interest, element 13, and the internal forces are 

provided in the bottom menu bar. These are the forces at the start of the member and the middle of 

the beam. 

3) Updating the Geometry -- 2nd-Order Elastic Analysis

Disp X Disp Y Disp Z Rot X Rot Y Rot Z

-4.818e-6 -0.007676 -0.005841 -3.356e-3 ~0 ~0
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If other critical locations for the displacement of the cross section are needed, we can duplicate the 

existing cross section that was modeled.

1) From the Geometry menu select Duplicate Element(s).

2) At the bottom menu bar, click in the edit box to the right of Delta x = and change 0 to -2. Ensure the 

check box next to Include Attributes is selected to include the property information is included.

3) Click the Adv button to open the pop-up menu. Ensure the check box next to X-axis is selected.

4) To select the illustrated cross section, click All next to the Element(s): window. Then click the 

Remove button.  

5) Repeatedly click the > button to the right of Times = to increase 1 to 5.

6) Click on the Apply button.

The analysis is not run again as the addition of these elements will not change the results. It would just 

provide more information on the displacement of the cross section. 

3) Updating the Geometry -- Additional Sections 
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This completes the tutorial.
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Section 1: Overview
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This tutorial provides step-by-step guidance for the sample joist structure. Enough details are 

provided that the example model with non-doubly symmetric sections can be completed following 

the instructions here. Not every feature available in MASTAN2 will be mentioned nor utilized in this 

tutorial. For further information on many of the features within MASTAN2 make use of other 

tutorials at http://www.mastan2.com/tutorial.html. 

Overview

http://www.mastan2.com/tutorial.html
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This tutorial works with a single open-web steel joist. The model will be created to show how to 

analyze a joist for a uniform distributed load on the top chord accounting for the non-doubly 

symmetric section properties. This model will then be adjusted to allow for the application of an 

eccentric point load on the bottom chord. Further details of each model will be provided in the 

corresponding section.

Problem Overview
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Section 2: Getting Started
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MASTAN2 is an interactive graphics program that provides preprocessing, analysis, and postprocessing 

capabilities. Preprocessing options include definition of structural geometry, support conditions, applied loads, and 

element properties. The analysis routines provide the user the opportunity to perform first- or second-order elastic 

or inelastic analyses of two- or three-dimensional frames and trusses subjected to static and dynamic loads. 

Postprocessing capabilities include the interpretation of structural behavior through deformation and force 

diagrams, printed output, and facilities for plotting response curves. MASTAN2 is based on MATLAB®, a premier 

software package for numeric computing and data analysis. 

In many ways, MASTAN2 is similar to today’s commercially available software in functionality. The 

number of pre- and post-processing options, however, have been limited in order to minimize the amount of time 

needed for a user to become proficient at its use. The program’s linear and nonlinear analysis routines are based on 

the theoretical and numerical formulations presented in the text Matrix Structural Analysis, 2nd Edition, by McGuire, 

Gallagher, and Ziemian. In this regard, the reader is strongly encouraged to use this software as a tool for 

demonstration, reviewing examples, solving problems, and perhaps performing analysis and design studies. Where 

MASTAN2 has been written in modular format, the reader is also provided the opportunity to develop and 

implement additional or alternative analysis routines directly within the program. 

MATLAB is a registered trademark of The MathWorks, Inc., 3 Apple Hill Drive, Natick, MA 01760-2098.

MASTAN2 General Information



M
AS

TA
N

2

Two versions of MASTAN2 have been developed and may be installed. One requires you to have 

access to MATLAB and the other does not. Both versions provide the same functionality, except that 

the MATLAB version also provides the user an opportunity to develop and implement additional or 

alternative analysis routines that will directly interact with MASTAN2. Please see the Setup Guides at 

www.mastan2.com. 

Launching MASTAN2

Start Here

http://www.mastan2.com/
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In order to minimize the learning time for MASTAN2, its graphical user interface (GUI) has been 

designed using a simple and consistent two menu approach. Using a pull-down menu at the top of the 

GUI, a command is selected. Parameters are then defined in the bottom menu bar and the command is 

executed by using the Apply button.

Base Layout

Main model window

Bottom menu bar

Edit Field

Pull-down menu

Submenu

Button
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Section 3: Base Joist Geometry
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While you can build the model and complete the analysis without saving or applying a title, due to the 

complexity of the model we will create a save file immediately. For the remainder of this tutorial, 

there will not be a reminder to save. However, it can be useful to save the file as you go along, 

particularly before any action that is not easily reversed as there is no undo feature. A file can be 

reopened while still working in that file without saving it to revert to the previous save version of the 

model that is unaffected by your last steps. 

1) Start with a new, empty model. 

2) From the File menu select Define title. At the bottom menu bar, click in the edit box to the right of 

Title: and type in a brief description of this effort. This text might include the model title, your 

name, and/or the assignment number. Click on the Apply button.

3) From the File menu select Save As … . After selecting your destination folder, type in the filename 

Joist and click Save. Note that the top of the window has now changed to include the file name and 

directory as well as the time the file was last saved.

Naming and Saving
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The joist will be modeled with the chords as two separate members to allow them to twist 

independently. The geometry could be input by defining individual nodes and then individual 

elements or making use of the extrude element tool extensively. Instead, the Input Geometry tool will 

be used to define most of the joist geometry. As a large part of creating the frame is the prep work, an 

explanation of what values were used is provided on this page and the next pages explain how to use 

the values and links to what the values are. 

The joist was defined as a series of nodes along the top chord and then the bottom chord. The first set 

is for the chords set back in the negative z-direction. The second set is for the chords in the positive z-

direction. The third set is on the x-y plane for member to member connections and the webs. The x 

position was defined based on the simple joist geometry. 

A node is defined for the end of the members, each web intersection, and where the joist bracing 

connects. The y position of the top chord nodes is set as 16” minus the centroid of the top chord angle 

while the bottom chord is 0” plus the centroid of the bottom chord angle. The z position similarly 

accounts for the centroid position plus a 1-1/8” gap between the chords. 

The elements are defined in order to connect all back chords, all front chords, all webs, and then the 

connections in between. 

Defining the Joist
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For entering the node coordinates and element information below, the values are provided in two 

different formats for your use. Node and element information needs to be copied only once.

A - Lists all the node information in separate readable segments to be copied in order.

B - Lists all the element information in separate readable segments to be copied in order.

C - Lists all the node and then all element information in small font lists to be copied all at once.

1) From the Geometry menu select Input Geometry .

2) At the bottom menu bar, Nodes should be already selected. In the edit box to the right of X_coord

Y_coord Z_coord, enter manually or copy and paste the coordinate values.

3) Click on Nodes to open a pop-up menu. Click on Elements to update what information is imported. 

4) In the edit box to the right of Node_i Node_j Beta(deg), enter manually or copy and paste the 

element start and end nodes. When only 2 values are provided, beta is assumed to be 0.

5) Click on the Apply button. 

Note: Apply button could be clicked before defining the Element list to just input the Nodes first. The Element list 

will then use the existing node information on the second use of Apply button.

Defining Geometry
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Copy all 3 tables in order

Nodes 1

0 15.54894 -1.01356
2 15.54894 -1.01356
25 15.54894 -1.01356
40 15.54894 -1.01356
48 15.54894 -1.01356
72 15.54894 -1.01356
96 15.54894 -1.01356
120 15.54894 -1.01356
144 15.54894 -1.01356
168 15.54894 -1.01356
192 15.54894 -1.01356
200 15.54894 -1.01356
215 15.54894 -1.01356
238 15.54894 -1.01356
240 15.54894 -1.01356
26 0.42775 -0.99025
32 0.42775 -0.99025
40 0.42775 -0.99025
72 0.42775 -0.99025
120 0.42775 -0.99025
168 0.42775 -0.99025
200 0.42775 -0.99025
208 0.42775 -0.99025
214 0.42775 -0.99025

Nodes 2

0 15.54894 1.01356
2 15.54894 1.01356
25 15.54894 1.01356
40 15.54894 1.01356
48 15.54894 1.01356
72 15.54894 1.01356
96 15.54894 1.01356
120 15.54894 1.01356
144 15.54894 1.01356
168 15.54894 1.01356
192 15.54894 1.01356
200 15.54894 1.01356
215 15.54894 1.01356
238 15.54894 1.01356
240 15.54894 1.01356
26 0.42775 0.99025
32 0.42775 0.99025
40 0.42775 0.99025
72 0.42775 0.99025
120 0.42775 0.99025
168 0.42775 0.99025
200 0.42775 0.99025
208 0.42775 0.99025
214 0.42775 0.99025

Nodes 3

0 15.54894 0
2 15.54894 0
25 15.54894 0
40 15.54894 0
48 15.54894 0
72 15.54894 0
96 15.54894 0
120 15.54894 0
144 15.54894 0
168 15.54894 0
192 15.54894 0
200 15.54894 0
215 15.54894 0
238 15.54894 0
240 15.54894 0
26 0.42775 0
32 0.42775 0
40 0.42775 0
72 0.42775 0
120 0.42775 0
168 0.42775 0
200 0.42775 0
208 0.42775 0
214 0.42775 0
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1 B. Chord

1 2
2 3
3 4
4 5
5 6
6 7
7 8
8 9
9 10
10 11
11 12
12 13
13 14
14 15
16 17
17 18
18 19
19 20
20 21
21 22
22 23
23 24

2 F. Chord

25 26
26 27
27 28
28 29
29 30
30 31
31 32
32 33
33 34
34 35
35 36
36 37
37 38
38 39
40 41
41 42
42 43
43 44
44 45
45 46
46 47
47 48

3 Webs

50 65
51 65
53 65
53 67
54 67
55 67
55 68
56 68
57 68
57 69
58 69
59 69
59 71
61 71
62 71

4 B. Conn.

50 2
51 3
53 5
54 6
55 7
56 8
57 9
58 10
59 11
61 13
62 14
65 17
67 19
68 20
69 21
71 23

5 F. Conn.

50 26
51 27
53 29
54 30
55 31
56 32
57 33
58 34
59 35
61 37
62 38
65 41
67 43
68 44
69 45
71 47

Copy all 5 tables in order
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Copy all values to 

the Node section

Copy all values to the 

Element section

Elements
1 2
2 3
3 4
4 5
5 6
6 7
7 8
8 9
9 10
10 11
11 12
12 13
13 14
14 15
16 17
17 18
18 19
19 20
20 21
21 22
22 23
23 24
25 26
26 27
27 28
28 29
29 30
30 31
31 32
32 33
33 34
34 35
35 36
36 37
37 38
38 39
40 41
41 42
42 43
43 44
44 45
45 46
46 47
47 48
50 65
51 65
53 65
53 67
54 67
55 67
55 68
56 68
57 68
57 69
58 69
59 69
59 71
61 71
62 71
50 2
51 3
53 5
54 6
55 7
56 8
57 9
58 10
59 11
61 13
62 14
65 17
67 19
68 20
69 21
71 23
50 26
51 27
53 29
54 30
55 31
56 32
57 33
58 34
59 35
61 37
62 38
65 41
67 43
68 44
69 45
71 47

Nodes
0 15.54894 -1.01356
2 15.54894 -1.01356
25 15.54894 -1.01356
40 15.54894 -1.01356
48 15.54894 -1.01356
72 15.54894 -1.01356
96 15.54894 -1.01356
120 15.54894 -1.01356
144 15.54894 -1.01356
168 15.54894 -1.01356
192 15.54894 -1.01356
200 15.54894 -1.01356
215 15.54894 -1.01356
238 15.54894 -1.01356
240 15.54894 -1.01356
26 0.42775 -0.99025
32 0.42775 -0.99025
40 0.42775 -0.99025
72 0.42775 -0.99025
120 0.42775 -0.99025
168 0.42775 -0.99025
200 0.42775 -0.99025
208 0.42775 -0.99025
214 0.42775 -0.99025
0 15.54894 1.01356
2 15.54894 1.01356
25 15.54894 1.01356
40 15.54894 1.01356
48 15.54894 1.01356
72 15.54894 1.01356
96 15.54894 1.01356
120 15.54894 1.01356
144 15.54894 1.01356
168 15.54894 1.01356
192 15.54894 1.01356
200 15.54894 1.01356
215 15.54894 1.01356
238 15.54894 1.01356
240 15.54894 1.01356
26 0.42775 0.99025
32 0.42775 0.99025
40 0.42775 0.99025
72 0.42775 0.99025
120 0.42775 0.99025
168 0.42775 0.99025
200 0.42775 0.99025
208 0.42775 0.99025
214 0.42775 0.99025
0 15.54894 0
2 15.54894 0
25 15.54894 0
40 15.54894 0
48 15.54894 0
72 15.54894 0
96 15.54894 0
120 15.54894 0
144 15.54894 0
168 15.54894 0
192 15.54894 0
200 15.54894 0
215 15.54894 0
238 15.54894 0
240 15.54894 0
26 0.42775 0
32 0.42775 0
40 0.42775 0
72 0.42775 0
120 0.42775 0
168 0.42775 0
200 0.42775 0
208 0.42775 0
214 0.42775 0
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1) From the Geometry menu select Extrude Element.

2) Click on the nodes on the bottom chord closest to the joist bridging connection: Nodes 18, 22, 42, 

and 46 to populate the nodes to be extruded.

3) Click in the edit box to the right of Delta y = and change 0 to 2.5. 

4) Click on the Apply Button.

5) Click on the new nodes above the back, bottom chord to the joist bridging. Depending on the exact 

order you clicked the previous nodes, the node index may vary. 

6) Click in the edit box to the right of Delta z = and change 0 to 0.99025. Increase the Times = from 1

to 2 by clicking on the > button. 

7) Click on the Apply Button.

Note: The elements created in Step 2 will need to be manually selected multiple times through this project. These 4 

elements will be referenced as the vertical braces after this point.

Lower Bridging Support
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1) From the Geometry menu select Subdivide Element(s). The top chord is to be meshed into 

approximately 8” segments. 

2) Click on the 4 top chord sections near the cross-bracing support to be subdivided 2 times.

3) Click on the Apply button.

4) Click the > box to the right of # of Segments = to increase 2 to 3.

5) In the bottom menu bar, use the buttons to the right of Element(s): to make the list of elements to 

be subdivided 3 times.

6) Click the Adv button to open pop-up menu. To select middle of the top chords, click the check box 

next to the X-axis option. Ensure the button to the right of Range (Inclusive) to change Off to On. 

Change the edit box to the left of X from –Inf to 48. Change the edit box to the right of X from Inf to 

192. Change the edit box to the left of Y from –Inf to 8. Click Add to select.

7) Click on the 4 remaining exterior top chord sections to be subdivided 3 times.

8) Click on the Apply button.

Top Chord Meshing
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1) The bottom chord is to be meshed into approximately 4” segments. 

2) Click on the 4-32” long bottom chord elements.

3) Click the > box to the right of # of Segments = to increase 3 to 4.

4) Click on the Apply button.

5) Click on the middle 4 bottom chord elements.

6) Click the > box to the right of # of Segments = to increase 4 to 6.

7) Click on the Apply button.

8) On the Advanced Element Selection pop-up, click the Reset button. Click the check box next to the 

X-axis option. Click the button to the right of Range (Inclusive) to change Off to On. Change the 

edit box to the right of Y from Inf to 8. Click Add to select the entire bottom chord.

9) Click the < box to the left of # of Segments = to decrease 6 to 2.

10)Click on the Apply button.

Bottom Chord Meshing
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1) The web is to be meshed into 4 equal segments. 

2) Click the > box to the right of # of Segments = to increase 2 to 4.

3) On the Advanced Element Selection pop-up, click the Reset button. Click the button to the right of 

Range (Inclusive) to change Off to On. Change the edit box to the left of Z from -Inf to -0.1 and to 

the right of Z from Inf to 0.1. Click Add to select all webs. 

4) Click on the Apply button.

Web Meshing
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1) From the Geometry menu select Remove Node(s).

2) Click on All Unattached to select all unconnected nodes that were included for simplicity in the 

initial model construction.

3) Click on the Apply button to remove. 

The next steps are not required; however, it will help make it easier to find results in the model.

4) From the Geometry menu select Renumber Elements.

5) Click the checkbox to the left of Y-X-Z (2D). Click on the Apply button.

6) From the Geometry menu select Renumber Nodes.

7) Click the checkbox to the left of Y-X-Z (2D). Click on the Apply button.

Model Cleanup
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1) From the Geometry menu select Extrude Element.

2) Click on the node at the middle of the bottom chord where the loading is to be applied. If you 

renumbered the model, this should be Node 167.

3) Click in the edit box to the right of Delta z = and change 0 to 1.5 to define the offset loading 

location.

4) Click on the Apply Button.

Eccentric Loading Location
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The steel joist model uses 6 sections. There is a separate entry for the top chord angle, the bottom 

chord angle, the three different web members, and a rigid link connector. 

The information can be input by 3 methods. If the section properties are all previously calculated, 

values can be entered directly. The information can be input individually via the Define Section

command after switching to the Advanced section properties interface or can be imported as a group 

via the Input Properties command. If the section properties need to be calculated, MSASect can be 

used calculate the information. 

This tutorial will first import all the section property information via the Input Properties command. 

Then it will demonstrate how MSASect could have been used to calculate the same information. The 

top chord angle will be calculated and saved, but not used as part of this analysis. 

Section Properties
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Cross-Section Geometry
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1) From the Properties menu select Input Properties.

2) At the bottom menu bar, Sections should already be selected. Copy and paste the values below into 

the edit box below |Name| Area Izz Iyy J Cw Zzz Zyy Ayy Azz Ysc Zsc BetaV BetaW Betaw Iyz. 

All members are entered in a principal orientation. The letter at the end of the name is to help remember the 

orientation with the corner of the angle members down and the opening of the channels up. 

3) Click on the Apply button. 

The section properties of the rigid element are approximated based on a 2” x 2” solid square as it has 

larger section properties than the majority of the joist elements. Combined with the higher modulus 

of elasticity will provide the effective rigid link. Care must be taken as too stiff of a link can cause 

issues with the solver and too soft will add unintended deformations.

Importing Section Properties

|Top Chord (V)| 0.36199 0.025692 0.13129 2.1666e-3 4.652e-5 0.083769 0.19214 Inf Inf -0.4957 0 0 2.1346 0 0
|Bot Chord (V)| 0.29895 0.01956 0.10058 1.3179e-3 3.4339e-5 0.066516 0.09328 Inf Inf -0.47698 0 0 2.0602 0 0
|Web 1 (U)| 0.29875 0.028641 0.054567 1.317e-3 3.3476e-3 0.081668 0.11919 Inf Inf -0.74007 0 0 1.8413 0 0
|Web 2 (U)| 0.26093 0.021852 0.047564 9.589e-4 2.5185e-3 0.066672 0.10367 Inf Inf -0.68065 0 0 1.7533 0 0
|Web 3 (U)| 0.15847 0.0072663 0.027533 3.1075e-4 7.4428e-4 0.029823 0.060575 Inf Inf -0.46984 0 0 1.4813 0 0
|RIGID| 4 1.33 1.33 2.25 64 4 4 Inf Inf 0 0 0 0 0 0
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1) Outside of MASTAN2, create a text file that summarizes the node and segment data similar to the 

one shown here.

2) From the Properties menu select Define Section.

3) At the bottom menu bar, click on the pop-up menu on the far right that currently displays Basic. 

Click on Advanced.

4) Click on MSASect.

5) After the interface loads, click the radio button next to General.

6) Click Next to open the editable general section interface. 

7) Click Open at the bottom of the screen.  

8) Navigate to the location of the text file. After selecting it, click Open.

9) Click Calculate to determine the properties.

10)Click edit box to right of Name: and enter Top Chord Alt. 

11)Click Export to MASTAN2 to copy values to main program. Click Close to return to main program.

12)Click Apply to save Section 7.

Calculating Section Properties
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Version to Copy for own Text File

Nodes
1,0.000000,-0.000000
2,-0.186234,-0.186234
3,-0.372468,-0.372468
4,-0.558703,-0.558703
5,-0.744937,-0.744937
6,-0.805247,-0.823534
7,-0.843159,-0.915062
8,-0.856090,-1.013284
9,-0.843159,-1.111506
10,-0.805247,-1.203034
11,-0.744937,-1.281631
12,-0.558703,-1.467865
13,-0.372468,-1.654100
14,-0.186234,-1.840334
15,0.000000,-2.026568
Segments
1,1,2,0.134000
2,2,3,0.134000
3,3,4,0.134000
4,4,5,0.134000
5,5,6,0.134000
6,6,7,0.134000
7,7,8,0.134000
8,8,9,0.134000
9,9,10,0.134000
10,10,11,0.134000
11,11,12,0.134000
12,12,13,0.134000
13,13,14,0.134000
14,14,15,0.134000
End
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Currently there are many elements and node labels that make it difficult to understand what is going 

on. While not necessary, this tutorial will turn off the labels. Following these steps again would allow 

the user to put the labels back into the model.

1) From the View menu select Labels and submenu option Node #s.

2) From the View menu select Labels and submenu option Element #s.

Improving Visual
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1) From the Properties menu select Attach Section.

2) At the bottom menu bar, use the buttons to the right of Element(s): to make the list of elements.

3) Click the Adv button to open pop-up menu. Click the Reset button. To select both top chords, click 

the check box next to the X-axis option. Click the button to the right of Range (Inclusive) from Off

to On. Change the edit box to the left of Y to 8.

4) Click Add to add the top chord elements to the element list. 

5) Click on the Apply button to assign Section 1 to the top chord elements. 

6) Change the Section # by clicking on the current section number just to the right to open a pop-up 

menu with all section numbers. Click on 2 to select the “Bot Chord (V)” section. 

7) Select the Clr button located to the right of Elements: to clear the list of elements. 

8) Change the edit box to the left of Y to 0. Change the edit box to the right of Y to 8.

9) Click Add to add the bottom chord elements to the element list. 

10)Click on the Apply button to assign Section 2 to the bottom chord.

Section Properties – Assigning – 1
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1) Change the Section # by clicking on the current section number just to the right to open a pop-up 

menu with all section numbers. Click on 5 to select the “Web 3 (U)” section. 

2) Select the Clr button located to the right of Elements: to clear the list of elements. Click Reset at 

the bottom of the Advanced Element Section.

3) Click the check box next to X-axis and the check box next to Z-axis.

4) Click All to the right of Element(s): and then Remove to select all the webs.

5) Click on the Apply button to assign Section 5 to all webs temporarily.

6) Change the Section # by clicking on the current section number just to the right to open a pop-up 

menu with all section numbers. Click on 6 to select the “RIGID” section

7) Select the Clr button located to the right of Elements: to clear the list of elements. 

8) Click the check box next to X-axis. Z-axis should still be selected.

9) Click Add to select all the rigid connectors. Additionally click on the 4 vertical braces.

10)Click on the Apply button to assign Section 6 to the rigid connectors. 

Section Properties - Assigning – 2
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1) Change the Section # by clicking on the current section number just to the right to open a pop-up 

menu with all section numbers. Click on 4 to select the “Web 2 (U)” section. 

2) Select the Clr button located to the right of Elements: to clear the list of elements. 

3) Click on all the elements to be assigned Web 2 section properties.

4) Assign Section 4 properties by clicking the Apply button.

5) Change the Section # by clicking on the current section number just to the right to open a pop-up 

menu with all section numbers. Click on 3 to select the “Web 1 (U)” section. 

6) Select the Clr button located to the right of Elements: to clear the list of elements. 

7) Click on all the elements to be assigned Web 1 section properties.

8) Assign Section 3 properties by clicking the Apply button.

Section Properties - Assigning – 3
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1) From the Properties menu select Define Material.

2) At the bottom menu bar, click in the edit box just to the right of E= and change the 0 to 29000000

(not 29,000,000). Similarly, click in the edit box just to the right of Fy= and change the inf to 50000. 

Next, click in the edit box to the right of Name: and type Steel. Click on the Apply button (Material 

#1 is now defined with the properties of steel).

3) At the bottom menu bar, click in the edit box just to the right of E= and change the 0 to 

2900000000 (not 2,900,000,000). Next, click in the edit box to the right of Name: and type Rigid. 

Click on the Apply button. (Material #2 is now defined 100x stiffer and cannot yield.)

Material Properties
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1) From the Properties menu select Attach Material.

2) At the bottom menu bar, create the list of elements to be assigned the properties of Material 1 by 

clicking on the All button to the right of Elements:. Click on the Apply button. (Note that elements 

with assigned section and material properties turn solid.)

3) Change the Material # by clicking on the current material number just to the right to open a pop-up 

menu with all section numbers. Click on 2 to select the Rigid material. 

4) Select the Clr button located to the right of Elements: to clear the list of elements. 

5) Click the Adv button to open pop-up menu. Z-axis check box should be selected. 

6) Click Add to select all the rigid connectors. Additionally click on the 4 vertical braces. Clicking Adv

will close the pop-up menu making it easier to click all members.

7) Click on the Apply button to assign Material 2. 

Material Properties - Assigning
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1) From the Conditions menu select Define Fixities.

2) At the bottom menu bar, define the lateral support by clicking in the check box just to the left of Z-

disp. 

3) Click the Adv menu. Change the edit box to the left of Y from -Inf to 15. Change the edit box to the 

left of Z from -Inf to -0.1 and the edit box to the right of Z from Inf to 0.1. Click the Add button. 

4) From the View menu select Zoom Box. Click to draw a small box around the brace connection on 

the bottom chord at one end. Click on the middle node to add to the list of nodes.

5) From the View menu select Fit. From the View menu select Zoom Box. Click to draw a small box 

around the brace connection at the other end. Click on the middle node to add to the list of nodes.

6) Click on the Apply button.

7) From the View menu select Fit.

Support Conditions - Bracing
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1) To update the end nodes to provide pin supports, start by clicking Clr to empty the list of nodes.

2) From the View menu select Zoom Box. Click to draw a small box around the right roller node. It 

should currently just have a lateral support. Click on the node to add to the list of nodes.

3) Define a roller support by clicking in the check box just to the left of Y-disp. Z-disp should still be 

selected from before.

4) From the View menu select Fit.

5) Click on the Apply button.

6) From the View menu select Zoom Box. Click to draw a small box around the left pin node.

7) Click on the Clr button to empty the list of nodes. Click on the left pin.

8) Define a pin support by clicking in the check box just to the left of X-disp. Y-disp and Z-disp should 

still be selected from before.

9) From the View menu select Fit.

10)Click on the Apply button.

Support Conditions – Pin and Roller
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1) From the View menu select Labels and submenu option Element local (x’-y’-z’) axes. The purple 

line shows the positive x axis. The blue line shows the positive geometric y axis. The red line shows 

the positive geometric z axis. Based on the orientation of the angle sections as input, the y axis 

represents the direction from the centroid to the corner of the angle.

2) From the Geometry menu select Re-orient Element(s).

3) At the bottom menu bar, click in the edit box to the right of Beta (Deg) and change 0.0 to 135. 

4) Click the Adv button to open pop-up menu. Click the Reset button. To select the +z top chord 

angle, click the check box next to the X-axis option. Click the button to the right of Range 

(Inclusive) to On. Change the edit box to the left of Y to 8. Change the edit box to the left of Z to 0.

5) Click Add to add all these elements to the element list. Click on the Apply button to re-orient the 

elements.

6) Repeat this for the remaining 3 angle members orienting in the correct direction with the values 

shown in the table:

Chord Member Orientation

Member -Z Top +Z Bottom -Z Bottom

Beta -135 45 -45

Y-Range 8 to inf 0 to 8 0 to 8

Z-Range -2 to 0 0 to 2 -2 to 0

Side View

Iso. View
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Note: Due to the input orientation of the chord 
angles, the blue line illustrates a line from 
the heel of the angle through the centroid. 
The white angle outlines are shown just for 
reference. They are not part of the 
MASTAN2 interface.
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Based on the orientation of the web sections as input, the y axis points in the direction of the opening 

of the channel.

1) At the bottom menu bar, click in the edit box to the right of Beta (Deg) and update it to 180. 

2) On the Advanced Element Selection pop-up, click the Reset button. Click the check box next to the 

X-axis and Z-axis option. Create the list of webs to be flipped by clicking on the All button to the 

right of Elements:. Then click on Remove. 

3) Manually click the 4 vertical braces, the members assigned Web 2, and the vertical web to the right 

of center. 

Note: If you are having trouble seeing the webs that were unselected, look at the image associated with Step 5 

now. The same elements are still selected without all the local axes information on the screen. Also, available 

again is the diagram with web orientations. 

4) Click on the Apply button to re-orient the elements.

5) From the View menu select Labels and submenu option Element local (x’-y’-z’) axes. 

Web Member Orientation
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Web members highlighted in red do not need to be flipped as the sections were defined.
These are the members that are to be unselected.
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1) From the Geometry menu select Define Connections and submenu option Torsion.

2) At the bottom menu bar, click on the menu to the right of Warping Restraint for Node i and set the 

value to Continuous. Repeat this for the Warping Restraint for Node j. 

3) Click the Adv button to open pop-up menu. Unmark the check box next to the X-axis option. The 

check box next to the Z-axis option should still be selected. 

4) Create the list of elements to be assigned continuous warping by clicking on the All button to the 

right of Elements:. Then click on Remove. Click on the 4 vertical braces to remove them.

5) Click on the Apply button. 

Adding Warping Effects
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1) Click Clr to empty the list of elements. 

2) Click on the menu to the right of Warping Restraint for Node i and set the value to Free. Node j is 

set from a previous step. 

3) Click on the left most element of each chord. 

4) Click on the Apply button. 

5) Click Clr to empty the list of elements. 

6) Click on the menu to the right of Warping Restraint for Node i and set the value to Fixed. Node j is 

set from a previous step.

7) Click on the top end of all 15 web members

8) Click on the Apply button. 

Adding Warping Effects – Starting Node
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1) Click Clr to empty the list of elements. 

2) Click on the menu to the right of Warping Restraint for Node i and set the value to Continuous. 

Click on the menu to the right of Warping Restraint for Node j and set the value to Free. 

3) Click on the right most element of each chord.

4) Click on the Apply button. 

5) Click Clr to empty the list of elements. 

6) Click on the menu to the right of Warping Restraint for Node j and set the value to Fixed. Node i is 

set from a previous step.

7) Click on the bottom end of all 15 web members.

8) Click on the Apply button. 

Adding Warping Effects – Ending Node
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1) From the Geometry menu select Define Connections and submenu option Flexure.

2) At the bottom menu bar, click on the menu to the right of Type for Node i and set the value to 

Semi-Rigid. 

3) In the edit box to the right of kz change inf to 0.001. 

4) Click on the top end of all 15 web members to create the list of elements. 

5) Click on the Apply button.

6) Click on the menu to the right of Type for Node i and set the value to Rigid. Click on the menu to 

the right of Type for Node j and set the value to Semi-Rigid. 

7) In the edit box to the right of kz change inf to 0.001. 

8) Click Clr to empty the list of elements. 

9) Click on the bottom end of all 15 web members to create the list of elements. 

10)Click on the Apply button.

End Moment Release
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Section 5: Loading and Analysis
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1) From the Conditions menu select Define Uniform Loads.

2) At the bottom menu bar, click on Element(s) local x’-y’-z’ to open the drop down menu. Select 

System global X-Y-Z. In the edit box just to the right of wy = change 0 to -12.5. 

3) Click the Adv button to open pop-up menu. Click the check box next to the Z-axis option to remove 

it. Click the check box next to the X-axis option. Click the Off button to the right of Range 

(Inclusive) to change it to On. Change the edit box to the left of Y to 8. 

4) Click Add to add the top chord elements to the element list. 

5) Click on the Apply button. The load will be split into the local element directions. 

6) From the View menu select Fit.

Distributed Loading
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

4) From the Results menu select Diagrams and submenu option Deflected Shape.

5) At the bottom menu bar, click on the Apply button.

To better see what deformation is occurring, it can be useful to make use of the other defined view. 

From the View menu select Defined Views and make use of the submenu options for these ideas. 

1) Option Front view: x-y.: How the vertical deflection is varying along the length

2) Option Side view: y-z.: How big the lateral deflection is compared to the joist

3) Option Top view: x-z.: How the lateral deflection varies along the length

4) Option Isometric: x-y-z.: Will return to the original view

It may be desired to update the deflected shape diagram with different scale factors during this 

process.

Uniform Loading Elastic Analysis
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1) From the Results menu select Node Displacements.

2) On the undeflected shape, click on the midspan node of interest, node 173, and the displacements 

for base 6 degree of freedoms are provided in the bottom menu bar. 

Calculated vertical deflection: 0.59 in

Estimated deflection using SJI recommendations:

𝐼𝑗 = 26.767 ∙ 𝑊 ∙ 𝐿3 ∙ 10−6 = 26.767 ∙ 297𝑝𝑙𝑓 ∙ 20𝑓𝑡 − 4𝑖𝑛 3 ∙ 10−6 = 60.47𝑖𝑛4

𝛿 = 1.15 ∙
5𝑊𝐿4

384𝐸𝐼
= 1.15 ∙

5 ∙ 300𝑝𝑙𝑓 20𝑓𝑡 − 4𝑖𝑛 4

384 ∙ 29000𝑘𝑠𝑖 ∙ 60.47𝑖𝑛4
= 0.66𝑖𝑛

Estimation using area of chords to calculate I:

𝐼𝐴 = 2 ∙ 0.29895𝑖𝑛2 ∙ 8.282𝑖𝑛 2 + 0.36199𝑖𝑛2 ∙ 15.121𝑖𝑛 − 8.282𝑖𝑛 2 = 74.87𝑖𝑛4

𝛿 = 1.15 ∙
5𝑊𝐿4

384𝐸𝐼
= 1.15 ∙

5 ∙ 300𝑝𝑙𝑓 20𝑓𝑡 − 4𝑖𝑛 4

384 ∙ 29000𝑘𝑠𝑖 ∙ 74.87𝑖𝑛4
= 0.53𝑖𝑛

3) From the Results menu select Element Forces.

4) On the undeflected shape, click on the span element of interest, element 204, and the internal 

forces are provided in the bottom menu bar. These are the forces at the start of the member.

Uniform Loading Results



M
AS

TA
N

2



M
AS

TA
N

2



M
AS

TA
N

2
M

AS
TA

N
2

Section 6: Hanging Load Analysis
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1) From the Results menu select Diagrams and submenu option None.

2) From the Conditions menu select Define Forces.

3) At the bottom menu bar, click in the edit box just to the right of PY = and change 0 to -100 to create 

a handing load.

4) Click on the node at the tip of the eccentric arm created at the end of the geometry modeling, node 

232. 

5) Click on the Apply button. 

Eccentric Loading
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1) From the Analysis menu select Static and submenu option 2nd-Order Elastic.

2) At the bottom menu bar, the Analysis Type: should already be set to Space Frame as desired. 

3) Click on the Apply button to perform the analysis. 

Eccentrically Loaded Joist Elastic Analysis
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1) From the Results menu select Node Displacements.

2) At the bottom menu bar, click on the Apply button.

3) On the undeflected shape, click on the midspan node of interest, node 173, to see how the change 

to the midspan deflection from the eccentric load.

4) On the undeflected shape, click on the node of the bottom chord attached to the eccentric loading 

arm, node 167, to see how the hanging load moved the chord.

Eccentrically Loaded Joist Elastic Results
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Using the results available within the MASTAN2 model, it is possible to calculate the internal stresses 

that the members are experiencing. Provided in this tutorial are the steps to pull the necessary values 

from MASTAN2 and the resulting stresses. 

Additional details on the necessary calculations are available in the “Pour Stop” tutorial.

Stress Calculations
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1) From the Results menu select Element Forces.

2) On the undeflected shape, click on the midspan element of interest, element 198, and the internal 

forces are provided in the bottom menu bar. These are the forces at the start of the member and 

the middle of the beam. 

3) These forces will be used to calculate the stresses at the middle of the beam.

4) At the bottom menu bar, drag the slider in the over left-hand corner until the position indicator just 

to the right displays 1.00L. 

5) Click on the Apply button. These are the forces at the end of the member. 

6) From this position, the bimoment is required to appropriately divide the longitudinal moment into 

the standard twisting and warping components for stress calculations.

7) Repeat these steps to get the internal forces in element 192. This is where the larger negative 

moment on the bottom chord now occurs. 

The forces at the start: The forces at the end:

Getting Internal Forces
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At Joint Mid Span

Including 
Bimoment*

Excluding 
Bimoment*

The resulting stresses are available for the locations identified on the sketch. The forces are 

calculated immediately after the web connection node and after the point load.

Stress Calculation Results

* Numerically bimoment exists in the model because the warping constant, Cω, is non-zero. Additional meshing of the model 
would refine the distribution of bimoment, but bimoment would still exist locally in the model at applied torque or supports 
and rapidly decrease to approximately zero along the majority of the length of the bottom chord. Since the evaluation of 
angles would often excludes the effects of warping, the internal stresses are provided having been calculated using the 
forces observed in this model including and excluding the bimoment values. 
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Stresses at Joint including Bimoment
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Stresses at Joint excluding Bimoment
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Stresses at Midspan including Bimoment
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Stresses at Midspan excluding Bimoment
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This completes the tutorial.
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